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A high-quality newsletter has the capacity to create a strong bond between 
your readers and your organization.
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Nielsen Norman Group*

showed that 69% of 
users look forward to 
receiving at least one 
email newsletter, and 
most users said a 
newsletter had become 
part of their routine.  
Users are drawn to 
email newsletters 
because they are 
informative, timely, 
predictable 
and convenient. 
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The Newsletter 
feature within 
LexisNexis® Publisher 
enables editors to 
select the best of the 
best from articles 
already deemed 
worthy to be 
published, which 
means that the most 
refined set of results 
can be delivered to 
key audiences.  
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The most successful 
newsletters show an 
understanding of the 
needs and interests of 
the target group. 
Newsletters are often 
used to target specific 
sets of users, such as 
project groups, 
account teams, 
practice areas, 
departments, or 
executives. 

*Nielsen Norman Group. Email Newsletter Usability (3rd edition), Executive Summary. Web 18 Nov. 2010.
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Workflow. New Newsletter Template
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Newsletter Landing Page Topic Selection Tab

Design Tab Recipients Tab

Tab flow for creating a new newsletter template.



Tab flow for creating a new newsletter issue.

Workflow. New Newsletter Issue

LexisNexis® Publisher / Newsletter Feature / Workflow 6

Newsletter Landing Page Article Selection Tab

Preview/Send TabRecipients Tab

Layout Tab

Notes Tab



Important guidelines for navigating the workflows

Workflow. Navigation Guidelines
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1. To navigate one page backward or forward within any workflow, click the Previous or Next buttons at the bottom 
of most workflow pages.  Changes you’ve made will be saved as long as you remain within the current workflow.

2. You may also navigate through the workflow – including skipping sections – by clicking directly on the workflow 
tabs at the top of each page.  

For instance, within the newsletter issue workflow, I may want to go from the Layout tab directly to Preview/Send, 
bypassing Recipients and Notes should I require no additions or changes on these pages.  Rather that "Next-ing" 
through pages I don't need to review, I may click directly on the Preview/Sent tab to skip ahead. Changes you’ve 
made will be saved as long as you remain within the current workflow.

3. If you wish to exit the current workflow you must click the Save Changes button first, otherwise changes will be 
lost.  Exiting the workflow includes returning to the Newsletter Home screen, navigating to any area within 
LexisNexis® Publisher not tied to the newsletter feature, or leaving Publisher altogether.  

Please also remember that Publisher times out after 20 minutes of inactivity, so if you’re in the middle of a 
newsletter workflow, remember to Save Changes before heading out to lunch, or else you work will be gone when 
you return.

Words to live by:  Save early, save often.



Newsletter Templates. Creation Process
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Newsletter templates define the customized look of the newsletter, the topics of interest for its target 
audience, and the default list of people who will receive it. LexisNexis® Publisher uses the information you 
define in this newsletter template to build each newsletter issue.

Start. New Newsletter Template
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Select radio button to the left of New Newsletter Template.

Type newsletter name.

Click Start.



The Topic Selection tab allows you to select specific topics for the template from the list of available topics.

Topic Selection. New Newsletter Template
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Select topics for your newsletter template from the list of available topics.

Click Next to move to the Design tab, which will keep your changes as long as you remain within the new template workflow.

Click Save Changes to save your progress if you wish to exit the new template workflow.  



The non-HTML design view enables you to design templates in a visual format without requiring any HTML coding.  
Real time previews can be seen in the preview pane to the right.

Design. New Newsletter Template
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Select between the non-HTML and the HTML view.

Choose to view/modify presentation options or 
font/color preferences.

Select between single column or dual column 
layouts.

Decide whether to include “View in Browser” 
link, helpful to readers using mobile devices.

Non-HTML Template Options

Select a logo from the uploaded images. 

Select size and color of LexisNexis® logo. 

Specify inclusion/location of Table of Contents.

Determine whether to truncate headline, and if 
so, specify headline length.

Select whether to include an abstract  (and 
specify its length), search hits, or neither.

Decide if editor’s article comments should be 
included and highlighted.

Click Previous to move to the Topic Selection tab, 
or Next to the Recipients tab; your changes will 
be kept as long as you remain within the new 
template workflow.

Click Save Changes to save your progress if you 
wish to exit the new template workflow.

Presentation Options



Non-HTML template design options continued.

Design. New Newsletter Template
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Select font color, font size, and 
font style for each text element 
of the newsletter template.

Click Previous to move to the 
Topic Selection tab, or Next to 
the Recipients tab; your 
changes will be kept as long as 
you remain within the new 
template workflow.

Click Save Changes to save your 
progress if you wish to exit the 
new template workflow.

Fonts/Colors Preferences

Select font type

Select color for alternating 
rows.



The HTML design view allows you to enter valid HTML for your headers and footers.

Design. New Newsletter Template
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Click Previous to move to the 
Topic Selection tab, or Next to 
the Recipients tab; your 
changes will be kept as long as 
you remain within the new 
template workflow.

Click Save Changes to save your 
progress if you wish to exit the 
new template workflow.

Add HTML header and/or 
footer, or opt to use defaults 
from Email display settings.

Select between the non-HTML 
and the HTML view.

HTML Template Options

Select between single column 
or dual column layouts.

Specify inclusion/location of 
Table of Contents.



Select newsletter subscribers on the recipients tab.

Recipients. New Newsletter Template
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If desired, filter list of recipients by first 
letter of last name to easily locate specific 
names.

Click Previous to move to the Design tab; 
your changes will be kept as long as you 
remain within the new template workflow.

Click Save Changes to save your 
newsletter template.

Enter your name in the “From” field to 
show recipients who sent the newsletter.  
The From field can also be customized on a 
per issue basis.

Select default recipients to receive the 
newsletter.  Recipients can also be 
customized on a per issue basis.  
Selections on each page will be saved if 
you choose to navigate between pages of 
subscribers.  Listing of potential recipients 
derived from Subscribed Users sub-tab 
beneath Administration.

Click Newsletter Home to return to the start 
page, where you can begin sending newsletter 
issues, or initiate other workflows.

Enter your email address in the “Reply to” 
field to enable recipients to send you 
feedback. The Reply-to field can also be 
customized on a per issue basis.

Enter a default email subject.  Email 
subjects can also be customized on a per 
issue basis.



Newsletter Templates. Other Workflows
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Should you need to make changes to the topics, design, or recipients originally selected for your newsletter 
template, follow the Edit Newsletter Template workflow to modify your choices.

Edit. Newsletter Template
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Select radio button to the left of Edit Newsletter Template.

Select the existing template you wish to modify.

Clicking Start will return you to the template workflow – Topic Selection, Design, Recipients – with your original selections 
displayed.  You may make modifications and re-save your template parameters.



Should you no longer need a saved template, follow the Delete Newsletter workflow to remove it from the system.

Delete. Newsletter Template

LexisNexis® Publisher / Newsletter Feature / Delete Template 17

Select radio button to the left of Delete Newsletter.

Select the template you wish to delete.

Click Start.

The Delete Newsletter Template pop-up will appear.  Click OK to delete the selected newsletter template along with any 
saved drafts associated with the template.  Click Cancel to discontinue the deletion process.



Newsletter Issues. Creation Process
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LexisNexis® Publisher uses the information defined in the newsletter template to build each newsletter issue.  A 
newsletter “issue” is a single iteration of a newsletter delivery, much like an issue of a magazine or newspaper.

Start. New Newsletter Issue
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Select radio button to the left of New Newsletter Issue.

Select the template from which you will create your newsletter issue.

Click Start.



The topics for the template are loaded in the left pane with published articles for each topic listed in the right pane.

Article Selection. New Newsletter Issue
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Click the name of the topic from 
which you wish to select articles.

Select “all” on the current page or  
just specific articles to include in 
your newsletter issue.   Click the 
headline to view full text in a 
separate window. 

Toggle between the full list of 
published documents and those 
selected for the issue.  Toggle 
options:  Show Selected/Show All.

Click arrows to navigate to the next 
group of documents (e.g. 11-20).

Click Next to move to the Layout 
tab, which will keep your changes 
as long as you remain within the 
new issue workflow.

Click Save Changes to save your 
progress if you wish to exit the 
new issue workflow.

Select a document range from the 
drop-down and click Go to navigate 
to a specific set of articles.



The Layout page enables you to use drag-and-drop technology to precisely place topics and articles within a 
newsletter issue for optimal presentation and impact.

Layout. New Newsletter Issue
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Click the drag and drop indicator 
(      ) to the left of a topic name to 
move the topic to another 
location within the issue.

Click Previous to move to the 
Article Selection tab, or Next to 
the Recipients tab; your changes 
will be kept as long as you remain 
within the new issue workflow.

Click Save Changes to save your 
progress if you wish to exit the 
new issue workflow.

Click the drag and drop indicator 
(     ) to the left of a headline to 
move the article to another 
location within the topic 
framework.



Recipients assigned to the newsletter template will be selected by default within the newsletter issue workflow.  
Additional subscribers can be added per issue and default subscribers can be deselected. 

Recipients. New Newsletter Issue
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If desired, filter list of recipients by first 
letter of last name to easily locate specific 
names.

Click Previous to move to the Layout tab, or 
Next to the Notes tab; your changes will be 
kept as long as you remain within the new 
issue workflow.

Click Save Changes to save your progress 
if you wish to exit the new issue 
workflow.

Enter your name in the “From” field to 
show recipients who sent the newsletter.  

Select/deselect recipients to receive the 
newsletter. Selections on each page will 
be saved if you choose to navigate 
between pages of subscribers.  Listing of 
potential recipients derived from 
Subscribed Users sub-tab beneath 
Administration.

Enter your email address in the “Reply to” 
field to enable recipients to send you 
feedback.

Enter email subject if different from template 
default.



Notes. New Newsletter Issue
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Click Save Changes to save your progress if you wish to exit the new issue workflow.

If you would like to add a note to the top of your newsletter delivery, you may do so on the Notes tab.

Enter notes within the text box.  Notes will appear at the top of your newsletter, beneath the header.    

• If a non-HTML template was used, then font type, color, size and styling (bold, italics, underline) will be controlled by the 
font/color preferences selected. 

• HTML coding is also valid in the text box, though not required.  If you wish to add additional styling, such as paragraph breaks, 
or want to insert a URL-based image, you may use standard HTML tags. 

• You may include links in the text box as long as the full path is defined (http://...).

Click Previous to move to the Recipients tab, or Next to the Preview/Send tab; your changes will be kept as long as you remain 
within the new issue workflow.



Preview/Send. New Newsletter Issue
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The Send button will become 
active (turn red) once changes 
are saved.  Click Send to launch 
your issue to all designated 
recipients.  A pop-up will ask 
you to confirm your intent to 
send your issue.

The Preview/Send tab allows you to view the newsletter issue as it would appear to the email recipient; 
workflow navigation enables access to previous screens if changes are needed prior to sending.

Click Previous to move to the 
Notes tab; your changes will be 
kept as long as you remain 
within the new issue workflow.

If you have not already done 
so, you must click Save 
Changes prior to sending your 
newsletter issue.  If you 
choose not to send the issue 
right away it will be stored as a 
draft.



Newsletter Issues. Other Workflows
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Saved issues are stored for thirty days so that they can be resent to recipients that missed the original delivery 
or accidentally deleted the email.

Resend. Newsletter Issue
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Select radio button to the left of Resend Newsletter Issue.

Select the template associated with the issue you wish to resend.

Clicking Start will return you to the recipients tab within the issue workflow.  No recipients will be selected since generally 
you will only be resending to select individuals who did not receive the original delivery.   Select recipients and proceed to 
the Preview/Send tab to launch the email.

Select the issue to resend.  Issues are identified by the template name, followed by the date and time of the last save.



Drafts are newsletter issues you have saved, but have not yet sent.  Drafts enable you to begin work on an 
issue, leave the workflow to perform other tasks, and return to complete the delivery.

Drafts. Newsletter Issue
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Select radio button to the left of Drafts.

Select the draft you wish to enter. Drafts are identified by the template name, followed by the date and time the draft was 
last saved.  Drafts will be kept until sent, or until the associated template is deleted.

Clicking Start will return you to the issue workflow – Article Selection, Layout, Recipients, Notes, Preview/Send – with your 
saved selections displayed.  You may make modifications and send the newsletter issue, or resave it to continue working later.



Newsletter Delivery. Best Practices
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Best Practices. Newsletter Delivery
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To present a superior user experience follow these 
best practices for newsletter delivery:

Change the “From” display and 
“Reply to” address  
to point to someone within your 
organization.  If the reader can instantly 
see that the newsletter came from 
within the organization they won’t 
mistake your email for spam. 

Keep the design of your 
newsletter simple.  
Don’t go overboard with an overly 
elaborate logo or use a multitude 
of font styles and colors all at 
once.  Users respond best to 
simplicity.

Write a good Subject line 
for your newsletter issue to 
immediately grab users’ 
attention and encourage them 
to read, rather than file or 
delete, your newsletter. 

Keep it brief to enable easy scanning.  
Most users skim headlines to get an 
overview, rather than reading thoroughly.  

• Select only the most relevant articles
• Include abstracts, but control their length
• Arrange articles in priority order
• Omit the table of contents if you aren’t   

including many topics

Don’t send too often.  
Research shows that the most 
frequent user complaint concerning 
newsletters, is that they arrive too 
often.  A predictable publication 
frequency that’s not too aggressive 
is best. 

Keep your content fresh and relevant.  
Create new topics/newsletters regularly 
to correspond to the latest issues facing 
your organization to keep people 
engaged.  Consider polling your audience 
about what they’d like to see and how 
often.



Need help?  Contact a LexisNexis® Publisher customer service specialist at 1-877-810-5325
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